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Dear Author, 

We want your book to be published quickly and at a reasonable cost. As 
you know, the typesetting costs account for a considerable proportion of 
the production costs. By using your personal computer (PC), these costs 
can be reduced and the book can be sold at a reasonable retail price. 

In the following instructions, we have summarized for you (and/or your 
colleagues) the most important rules for the layout of your book; they are 
designed to help you produce a well-designed copy for printing. 

In addition, we are sending you a document template for Word 95, 97, 
and 2000 and for Word for Macintosh, which contains all the necessary 
formatting. Please use 

• the template SVcrmono-e.dot for monographs, 
• the template SVcrproc-e.dot for anthologies and proceedings. 

In order to save both you and us unnecessary work at a later stage, 
please read these instructions carefully. The organization, layout, and ty-
pography shown here exactly corresponds to the specifications that are 
explained in these instructions and may therefore serve as a guide for pro-
ducing your book. 

If you have any questions, please do not hesitate to contact us to clarify 
problems at an early stage and to agree on any additions or changes that 
may be necessary. 

You can reach us at the following number/address: 

Name:       

Tel.:        

Fax:        

e-mail:       
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1 Preparation 

It is usually sensible to work on the content of the book, i.e., writing the 
text, and on the layout in separate steps. 

First write your text and give your headings the correct format using the 
relevant buttons in Springer's document template. 

Ask someone to read through the text after you have written it. If you 
wish to publish in English and English is not your native language, please 
ask a native speaker to help you or arrange for your text to be checked by 
one of our copy editors; please insert their final corrections into your data. 

Write your text before you begin on the layout of the book. 

Then format the text and tables in accordance with the principles ex-
plained below and add the figures. 

Once you have completed two or three chapters, please send a represen-
tative sample chapter, including figures and tables, to the contact at 
Springer-Verlag indicated above. If necessary, we can then give you fur-
ther tips on how to implement our instructions on layout. 

Recommendation: Save each chapter in a separate file and give the files 
the chapter number (e.g., 01.doc, 02.doc). 





2 Springer's Document Template 

2.1 Getting Started 

Step 1: Copying the Document Template to Your Hard Disk 

• If you are working on a PC using Windows, copy the file SVcrmono-
e.dot or SVcrproc-e.dot into the directory containing your Word docu-
ment templates. (Start Word and choose Tools – Options “File 
Locations” to see where the document template should be saved.) 

• If you are using a Macintosh, first open Word and choose File Open and 
the file type ”Templates”. Open the file SVcrmono-e.dot or SVcrproc-
e.dot, choose Save As, and save the file under the name SVcrmono-e or 
SVcrproc-e (without the extension ”dot”) in your template folder. This 
will usually be Programs\Word\Templates. 

Step 2: Attaching the Template to Your Document 

Before you start work, open a new or an existing Word document and 
choose the menu point Templates and Add-ins in the Tools menu (Word 97 
and 2000) or the menu point Templates in the File menu (Word 95). Click 
on ”Attach” in the dialog box, choose SVcrmono.dot or SVcrproc.dot, and 
click on ”Update Styles” and then OK. 

Macrovirus Protection: If the macrovirus protection is activated on your 
PC, a warning will appear to tell you that the template contains macros. 
We have checked the template for viruses and assure you that it does not 
contain any viruses we are familiar with and that you can use the macros. 

2.2 Toolbars 

On the far right, a new menu point now appears: Toolbars. The Toolbars 
menu contains four items:  
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• You can use the first three items, Title and Headings, Text, and Figures 
and Tables, to display and hide the toolbars containing the buttons for 
the various formats. 

• Change Margins is used to choose a range of preset options in Word 
automatically, such as margins, automatic hyphenation, and typesetting 
quotation marks. 

Use this tool as the first thing you do when you start work. 

2.3 Formatting and Layout Using the Buttons 

In order to format existing text, place the cursor in the appropriate section 
and then click on the button; the section will be formatted accordingly. 

If you are writing new texts, click on the button before you type in the 
text. 

There is also a keyboard shortcut for each function (see the list in the 
Appendix). 



3 Text Layout 

3.1 Page Layout 

Your book project will appear in the format 15.5×23.5 cm 
(width × height). The printed area of each page, known as the type area, is 
11.7×18.8 cm. The header (running headline) appears above the type area. 

 

The Change Margins function in our document template can 
be used to set up the type area automatically. 

Always use the entire height and width of the type area. In exceptional 
cases, the type area may be shortened by a line to avoid having the first 
line of a new paragraph at the end of a page or the last line of a paragraph 
at the beginning of the next page. To do so, please enter a manual page 
break (click on Break in the Insert menu). 

The type area also has to be reduced if there is only space for one line 
after a heading; in this case, the paragraph should appear on the next page 
together with the heading. 

3.2 Fonts 

For running text, the fonts Times or Times New Roman, and for titles and 
headings the fonts Helvetica or Arial should be used. 

 

The correct fonts and font sizes are preset in Springer's docu-
ment template. 

3.3 Titles and Headings 

The following levels of titles/headings may be used: 

 
1 Title of the chapter/contribution 
The title  should always appear at the top of a new page. 
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 1.1 First-level heading 

 1.1.1 Second-level heading 

  Third-level heading (no number) 

Fourth-Level Headings. If a further level of headings is necessary, you 
may set the heading directly at the beginning of the relevant paragraph 
(”run-in heading”). The paragraph should not be indented; in addition, 
click on the ”Line Space” button and set the run-in heading in bold. 

The spacing that should be used before and after the headings is given in 
the Appendix. 

 

The correct fonts and font sizes are preset in Springer's docu-
ment template. 

Note: If two headings of different categories appear one after the other in 
the text, the spacing between them has to be reduced. To do so, select the 
second heading and choose Format – Paragraph. Set ”Spacing Before” to 
0. 

Please insert a blank space, without a period, after the heading numbers. 
Try to limit the text of the heading to one line; otherwise problems will 
arise when the headers are inserted automatically (see Chap. 8). 

3.4 Text 

Use the following two buttons to format the paragraphs of text: 

 The first line of a paragraph is not indented after a heading. 
This format will appear automatically if you press ↵ at the 
end of a heading. 

 In all other paragraphs of text, the first line is indented. 

Petit 

Examples and quotations of some length can (but do not have to be) set in 
a smaller font size. 

 Use the ”Petit” button to do so. 

Example 
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The caretaker of a fairly large residential complex was seriously ill. Despite all 
the relevant examinations being performed, a clear diagnosis could not be estab-
lished. After a series of treatments had been attempted without success, a young 
resident physician discovered that the man had caught an infection from a woman 
living in the house who had returned from the Tropics; the woman herself has not 
developed any symptoms to this date. 

The pathogen that causes this disease is unknown. This example shows that thorough 
anamnestic inquiries may sometimes be more important than routine diagnostic procedures. 

Displayed Lists 

Springer's document template offers you three different options for pre-
senting displayed lists: 

 Displayed lists with bullets 

 Displayed lists with dashes 

 Displayed lists with numbers 

 Line spacing of 0.2 cm should be inserted before and after a 
displayed list. To do so, place the cursor a) in the first line of 
the displayed list and b) in the first line of the text following 
the displayed list and then click on the button. 

Try to present simple, one-column displayed lists in the same way 
throughout the book. Do not refer to displayed lists such as these as ”Ta-
bles”. 

Emphasis in the Text 

Please set emphasized words, phrases, or sentences in running text in italic 
type. Only use boldface for emphasis if absolutely necessary, and even 
then use it sparingly, as it interrupts the flow of the text. 

 Important passages of text such as notes and warnings may 
also be given a frame. 

Caution: Too much emphasis may actually confuse readers instead 
of making it easier for them to find their way around the text. You 
should therefore be economical in your use of emphasis. 
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Footnotes 

In running text, the footnotes should be marked with superscript numbers1. 
 

 This button can be used to call up the footnote function; the 
footnotes are numbered automatically and added to the end 
of the page. 

3.5 Particular Aspects of Inserting Text 

Hyphens, En Dashes, and Em Dashes 

These various types of hyphens and dashes are of different lengths and 
have different spacing on either side. 

Hyphens correspond to the normal hyphen on the keyboard. 

• Hyphens to divide words at the end of a line are automatically inserted 
by the hyphenation program. 

• Normal hyphens are used in compound words to connect words or to in-
dicate that (part of) a word has been left out, e.g., cost-benefit analysis, 
pre- and perinatal medicine. 

En and em dashes are not identical to hyphens; they are about twice as 
long. To insert them, please press Ctrl and – on the numbers block (Ctrl + 
Num –). 

• En dashes are set without any spaces in between, e.g., 8–16 years, 
Fig. 5a–f. 

• In contrast, a space should be inserted as shown here – using the space-
bar – before and after em dashes. 

Soft Hyphens 

Despite automatic hyphenation, it is sometimes necessary to insert a hy-
phen manually. On no account should you use a normal hyphen for this, as 
a normal hyphen still appears in the word even if changes are subsequently 
made to the text and the word thus no longer appears at the end of a line. 
Instead, use the key combination Ctrl + - to insert a ”soft hyphen”. If the 
text subsequently moves, this hyphen is automatically removed again. 

                                                      
1 Remember to put a period at the end of the footnote. 
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Quotation Marks 

In order to use typesetting quotation marks (”curved quotes”), the corre-
sponding function in Word has to be activated. This is done automatically 
if you chose Toolbars – Change Margins at the start. 

Hard Spaces 

To ensure that parts of abbreviations that belong together and figures and 
units are not separated at the end of a line, a normal space (using the 
spacebar) should not be used. Instead, press Ctrl + Shift + Spacebar to in-
sert a ”hard space”. (A small circle, similar to a degree sign, appears on 
screen; it will disappear if you click on ¶ to hide formatting characters.) 

3.6 Spelling 

Please ensure that the spelling of names, terms, and abbreviations is con-
sistent, including in tables and figures legends. 

3.7 Abbreviations and Units 

Abbreviations 

• Please use the following abbreviations for cross-references in your 
book: 
p./pp. (page/s) 
Chap./Chaps. (chapter/s) 
Sect./Sects. (section/s), 
Fig./Figs. (figure/s). 
Note: The word "Table" should never be abbreviated. 

• Please ensure that standard abbreviations, such as approx., i.e., etc., f., 
ff., e.g., are used consistently. 

List of Abbreviations. If you use a large number of technical abbrevia-
tions, you should make a list of abbreviations; it should appear before the 
beginning of the text (at the end of the front matter, see Chap. 10). You 
may also spell out abbreviations at first use in the text, e.g.,: 

In epidemiologic terms, coronary heart disease (CHD) is the most important. 
Last year, 15% of hospital beds were occupied by CHD patients. 
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Note: Please do not use abbreviations at the beginning of a sentence; the 
words should be written out in full. 

Units 

Please ensure that you always use internationally accepted signs and sym-
bols for units (e.g., g for gram, m for meter, s for second, p for physical 
pressure). 

3.8 Selecting Index Entries 

You can select terms that are to be included in the index while entering the 
text. Please read the relevant instructions in Chap. 9. 



4 Equations 

Equations should appear on separate lines. They are numbered chapter-
wise. The equation number is given in parentheses as right aligned text 
next to the equation (see Eq. 4.1). 

(a+b)2 = a2+2ab+b2 (4.1) 

 This button inserts two table cells. There is a box on the 
right for the equation number, and a box on the left for the 
equation itself. 

Simple equations of the type a2+b2=c2 can be written as normal text. For 
all other equations, please use MathType or the Microsoft Equation Editor, 
and insert the graphic into your text file as an object. 

If the equation is part of a sentence, it should end with a punctuation 
mark (not after the equation number). 

References to equations in the text are abbreviated as Eq. (equation) or 
Eqs. (equations). 





5 References 

5.1 Citations in the Text 

References may be cited in the text in two different ways: 

Author Name(s) and Year of Publication in Parentheses 

• One author: (Miller 1991) 
• Two authors: (Miller and Smith 1994) 
• Three or more authors: (Miller et al. 1995) 

Two or more years after an author's name should be divided by a 
comma, while several authors with the relevant year of publication should 
be divided by a semicolon: (Miller 1991, 1993; Smith 1998). 

Reference Numbers in Square Brackets 

• [3, 7, 12]. 

The number system is particularly suitable for large numbers of references. 

 Inserts the square brackets and places the cursor between the 
brackets so that all you have to do is type in the reference 
number. 

Note: In most subject areas the reference list should be alphabetical, even 
if reference numbers are used. If subsequent changes are made, the refer-
ences have to be renumbered accordingly. In some areas (e.g., chemistry) 
citations are numbered in order of their appearance in the text. Check with 
your Springer contact if you are unsure which order to use. 
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5.2 Reference List 

Heading 

If there is a joint reference list for all the chapters at the end of the book, 
the heading ”References” should appear in the same size as a chapter title 
(”Title” button), but without a number. If each chapter has its own refer-
ence list at the end of the chapter, the heading ”References” should appear 
as a first-level heading (”H1” button), also without a number. 

Style 

 Use this button to style the entries in the reference list. 

The reference list should be alphabetical (even if reference numbers are 
used). If there are several works by the same author, the following order 
should be used: 

• first, all works by the author alone: 
ordered chronologically by year of publication, 

• next, all works by the author with a coauthor: 
ordered alphabetically by coauthor, 

• finally, all works by the author with several coauthors: 
ordered chronologically by year of publication. 

Bibliographic Abbreviations 

Volume  vol 
Edition  edn 
Editor/s  ed/eds 
Page/s  p/pp 

5.3 Examples 

The system used in the examples below is followed in most subject areas. 
If different rules need to be followed in your subject area, you will be 
given the necessary information by your contact at Springer-Verlag. 
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Monographs 

Ball JC, Ross A (1991) The effectiveness of methadone maintenance treatment: 
patients, programs, services and outcomes. Springer, Berlin Heidelberg New 
York 

Jellinek EM (1960) The disease concept of alcoholism. Hillhouse, New Haven 
Snider T, Grand L (1982) Air pollution by nitrogen oxides. Elsevier, Amsterdam 

Anthologies and Proceedings 

Noller C, Smith VR (1987) Ultraviolet selection pressure on earliest organisms. 
In: Kingston H, Fulling CP (eds) Natural environment background analysis. 
Oxford University Press, Oxford, pp 211–219 

Treasure J, Holland AJ (1989) Genetic vulnerability to eating disorders: evidence 
from twin and family studies. In: Remschmidt H, Schmidt MH (eds) Child 
and youth psychiatry: European perspectives. Hogrefe and Hubert, New 
York, pp 59–68 

Zippel J, Harding FW, Lagrange M (1992) The stress of playing God. In: Mildor 
E (ed) Explorations in geopolitics, 4th edn. Wiley, New York, pp 103–124 

Journal Articles 

Arkhipenko DK, Bokiy GB (1986) Factor-groups analysis and X-ray study of 
vermiculite and talc cristals (in Russian). J Struct Chem 16:450–457 

Peters S, Jaffe HG (1991) Lactose synthesis and the pentose cycle. J Biol Chem 
98:15–33 

Uno H, Tarara R, Else JG, Suleman MA, Sapolsky RM (1989) Hippocampal 
damage associated with prolonged and fatal stress in primates. J Neurosci 
9:1705–1711 

Note: In medicine and associated disciplines, the names of journals should 
be abbreviated as indicated in Index medicus. In case of doubt, please give 
the full name. 

Special Cases (Theses, Reports) 

Boshoff GA (1999) Development of integrated biological processing for the 
biodesalination of sulphate- and metal-rich wastewaters. Ph.D. thesis, Rhodes 
University 

Dyrynda PEJ (1996) An appraisal of the early impacts of the 'Sea Empress' oil 
spill on shore ecology within South-West Wales. (Final report by the Univer-
sity of Wales, Swansea for the Wildlife Trusts and WWF-UK) 

Saavedra C (1989) Manu – two decades later. WWF report June/July. WWF, 
Gland, pp 6–9 
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Numbered Lists 

 8. ....... 
 9. Peters S, Jaffe HG (1991) Lactose synthesis and the pentose cycle. J Biol 

Chem 98:15–33 
10. Snider T, Grand L (1982) Air pollution by nitrogen oxides. Elsevier, Amster-

dam 
11. Uno H, Tarara R, Else JG, Suleman MA, Sapolsky RM (1989) Hippocampal 

damage associated with prolonged and fatal stress in primates. J Neurosci 
9:1705–1711 

12. … 

Please do not put commas between names and initials, and do not 
put periods after initials or abbreviations. 

 



6 Tables 

Tables should be used to present the results of investigations and large sets 
of figures clearly. 

Tables are set in a smaller font size than the rest of the text. They always 
consist of the following elements: 

• The table heading 
• The actual table 
• Table notes, where applicable 

Tables should have at least two rows and two columns. Simple, one-
column lists should not be treated as tables, but instead should be 
incorporated in the running text. 

Springer's document template makes it easier to create tables by using the 
following commands: 

 The word ”Table” and the table number are inserted auto-
matically; all you need to do is to insert the chapter number 
and the heading. 

 
Opens a dialog box allowing you to specify the number of 
rows and columns you need. 

 
Insert Rows: Adds a row above the cursor position. 
Delete Rows: Deletes the row in which the cursor is in. 

 
Insert Columns: Adds a column to the left of the cursor po-
sition. 
Delete Columns: Deletes the column in which the cursor is 
in. 

 
Formats the table as shown in the example printed below. 
Place the cursor anywhere in the table and click on the but-
ton. 

 
Place the cursor directly beneath the table, click on the but-
ton, and write the table note . If there is text following the 
note, insert a blank line. 
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Tables should be placed near the relevant citation in the text. However, 
if possible, tables should appear either at the beginning or the end of a 
page. 

 
 

Table 6.1. Cardiovascular parameters 

Patient no. psyst art⋅HR psyst art 
maximum 
[mm Hg] 

HR 
[min–1] 

ECG CHD 

 5a 25,038 214 214 ES Yes 

 8a 14,220 237   60 ES Yes 

14a 11,350 165  111 ES No (?) 

23b 18,128 175   90 ES, ST Yes 

39b 22,785 218   68 ES Yes 

p  physical pressure, HR  heart rate, ECG  electrocardiogram, CHD  preopera-
tively diagnosed coronary heart disease, ES  extrasystoles, ST  sedimentation time. 
aPatients in Group 1. 
bPatients in Group 2. 

Notes 

Tables are structured using horizontal lines above and below the column 
headings and a line beneath the columns. If necessary for didactic reasons, 
further lines, both horizontal and vertical, may be inserted. 

Information in cells should be flush left, but numbers should be ar-
ranged ”decimally”, i.e. all the units, tens, hundreds etc. underneath one 
another. Metric/physical units in the column headings should be set in 
square brackets. 

Notes on abbreviations should be given below the final row of the table 
and should be flush left; the abbreviations to be explained should be set in 
italic type. 

Footnotes in tables should be indicated by superscript lower-case letters. 
The footnotes themselves should appear beneath the table and should be-
gin with a capital letter and end with a period. 

The word ”Table” is not generally abbreviated. It should appear in the 
table heading with the relevant number in bold. If a table does not fit on a 
page and has to be continued on the next page, you should not repeat the 
entire table heading, but only the following: 
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Table 6.1. (cont.) 





7 Figures 

7.1 Line Drawings 

Please let us know which graphics program you have used. Adobe Illustra-
tor, Macromedia Freehand, and Corel Draw are suitable programs to use. 

• Compile the figures in the same size as they are to appear in print: max. 
11.7 cm wide and 18 cm high. 

• Please use the fonts Arial or Helvetica (if possible as PostScript fonts) 
for lettering. Lettering should be at least 7 pt. 

• Avoid decorative effects such as shading, gradient fills and strokes, out-
line letters, and frames. 

• Instead of fill color, use dot patterns with gray tones of 15%, 25%, and 
40% and ensure that there is clear contrast; any text in such areas should 
be clearly legible. 

• The lowest line weight is 0.4 pt. 
• If figures are to be printed in black and white, please do not use color. 
• Line drawings should be saved as *.eps. Please ensure that all the fonts 

are included. 

7.2 Scanning 

• The minimum resolution for scanned line drawings is 600 dpi; for pho-
tos (grayscale pictures), 300 dpi is sufficient. These values refer to the 
final size of the figures. If the figures have to be enlarged or reduced in 
size, the correct scanning resolution can be calculated as followed: 

600 (or 300) dpi multiplied by the enlargement or reduction factor. 

• Photos (grayscale pictures) should be saved as *.tif; figures with a large 
amount of lettering should preferably be saved as *.eps (include fonts). 

• Screenshots should also be saved with a resolution of 300 dpi. 
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7.3 Inserting the Figures into the Word File 

Place the figures at the beginning or the end of a page so as to interrupt the 
flow of the text as little as possible. 

• Insert a blank line between the text and the figure. 
• Place the cursor in the following line. 
• Choose the ”Insert Graphic” button or Insert – Picture in the menu bar 

to select your graphics file. 

 This button opens the ”Insert Picture” dialog box. 

Note. In the ”Insert Picture” dialog box, you have a choice between ”Link to File” 
or ”Save Picture in Document”. 

If you choose ”Link to File”, the original place where the picture is saved re-
mains the same; the picture is merely shown in the document and can be printed 
out. This method is recommended for large graphics files, as it avoids making the 
text document unnecessarily large. Please remember to submit the original graph-
ics files. 

If you choose the option ”Save Picture in Document”, the graphics data are in-
cluded directly in the text file. Here, too, it is a good idea to submit the original 
graphics files as well. 

Enlarging, Reducing and Selecting Areas 
(only for Word 97 and 2000) 

• Click on the picture; eight selection handles will appear. At the same 
time, the Picture menu bar appears. 

• By clicking on and holding down the left mouse button, you can drag 
the selection handles and, hence, change the size of the pictures. (If you 
click on a corner and drag the handle, the width and height will be 
changed proportionally.) 

• The ”Crop From” button in the picture toolbar can be used to select ar-
eas. 

• If a crosshair appears at the tip of the arrow, the entire picture can be 
moved. 

Figure Legends 

The figure legend should always appear beneath the figure and should con-
tain the title of the figure and any explanations necessary for the reader to 
be able to understand it.  

 ”Fig.” and the figure number are inserted automatically; all 
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you need to do is to add the chapter number and the legend 
itself. 

The abbreviation ”Fig.” and the figure number should appear in bold, as 
should any figure parts (a, b, c etc.). Lettering in the figure that is ex-
plained in the legend should be set in italic type in the legend. Legends 
should not generally end with a period. Please insert a blank line after the 
legend. 

Example 
 

Start

Read next
claim

Read
AVG (interest rates)

Calculate
total claim

Finish

10

0.05 - 0.2 s

0.2 - 0.3 s

0.05 - 0.1 s

Time required

 

Fig. 7.1. Simplified performance model of a critical access module 





8 Headers and Page Numbers 

The page numbering should begin on the first page of the first chapter of 
the book, which is always a right-hand (odd-numbered) page. The page 
number appears in the so-called running headline (header), which also con-
tains the title of the current chapter. In monographs, the chapter title 
appears on the left-hand page and the first heading on the right-hand page; 
in anthologies and proceedings, the author name(s) appear(s) on the left-
hand page and the title of the contribution on the right-hand page. 

8.1 Headers 

Headers and page numbers appear in a smaller font size (9 pt) and are 
separated from the text by a line. For aesthetic reasons, the first page has 
no header, but is included in the automatic page numbering. 

The headers will be inserted automatically if you write new text using 
the document template.  

If you format existing text, click on the first page and then on . 

8.2 Page Numbers 

It is best not to insert the final page numbers until all chapter have been 
completed. You should proceed as follows: 

• Open Chap. 1 (file 01.doc). 
• Make a note of the number of the last page of Chap. 1. 
• Open Chap. 2 (02.doc). 

• Click on the header and then on . Insert the (odd) page number 
that Chap. 2 should begin with at the bottom left of the dialog box under 
”Page Numbering – Start At”. 

• Make a note of the number of the last page of Chap. 2. 
• Open Chap. 3 (03.doc). 
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• etc. 

Note: If the text and page numbers change due to subsequent alterations, 
you will need to correct the page numbers in the chapters that follow.  



9 Index 

The alphabetical index is an important guide to help readers find what they 
are looking for in an academic or scientific book. You can decide which 
terms should be included in the index as keywords while you are working 
on the text. 

Only include those terms on which you, as a reader, would look for 
more detailed information. 

A sample index is printed at the end of these instructions. 

9.1 Selecting the Keywords 

 In order to indicate which terms should be included, select 
the relevant word and then click on the button. 

The term now appears as a main entry in the ”Mark Index Entry” dialog 
box. Click on ”Mark” to save the term as an index entry. 

If the term you have selected is a subentry, you will need to copy it into 
the ”Subentry” box and type in the main term under ”Main Entry”. Then 
click on ”Mark”. 

Note: Never click on ”Mark All”; otherwise all incidences of the word that 
has been selected will be included in the index. 

9.2 Creating an Index 

The index appears at the end of the book as a separate chapter with the title 
”Index” (without a chapter number), beginning on a right-hand page. 

 

Our document template can be used to create the index auto-
matically. 
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• Ensure that the formatting characters and marked index entries are 
shown on screen. If they are not, click on the ¶ button. 

• Place the cursor under the title ”Index”. 

• Click on the button  
The following box appears: { RD c:\\} 

• Now enter the file name of the first chapter and the path as follows: { 
RD drive:\\directory\\subdirectory (if applicable)\\file name.file name 
extension}. 
It might look like this: { RD c:\\My Documents\\book\\01.doc}. 

• Now go to the next line, click on  again, and enter the path for the 
next chapter etc. 
{ RD c:\\book\\01.doc} 
{ RD c:\\book\\02.doc}  
{ RD c:\\book\\03.doc}  
{ RD c:\\book\\04.doc}  
{ RD c:\\book\\05.doc} 

 If you click on this button, the complete, two-column index 
will be created automatically. 

Note: Do not use this function until all the chapters have been completed 
and you have checked that each chapter begins with the correct page num-
ber. 

If you make subsequent modifications to individual chapters causing 
changes to the text and page numbering, you will need to alter the index 
accordingly. To do so, select the entire index and press F9. 



10 Front Matter and Table of Contents 

10.1 Order 

The parts of a book that appear before the actual text are referred to as the 
front matter. They include the following: 

• Half-title page (an empty page with the publisher's mark, pp. I–II) 
• Title page (p. III) 
• Imprint page (p. IV) 
• Foreword, if any 
• Dedication, if any 
• Preface 
• Table of contents 
• List of contributing authors (with complete addresses), if applicable 
• List of abbreviations, if any 

The first 4 pages of the front matter are designed by the publisher, but 
please submit a draft of the title page. The other pages should be numbered 
using Roman numerals, beginning with p. V. 

The titles of all the main sections (Foreword, Preface, Contents etc.) 
each appear on a right-hand (odd-numbered) page and are treated as chap-
ter titles. 

10.2 Table of Contents 

All the headings up to the third level are usually included in the table of 
contents. 

 

Our document template can be used to create the table of con-
tents automatically. 

The table of contents is created in the same way as the index (see 
Chap. 9): 
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• Ensure that the formatting characters and selected titles and headings are 
shown on screen. If they are not, click on the ¶ button. 

• Place the cursor under the title ”Contents”. 

• Click on the button  
The following box appears: { RD c:\\}  

• Now enter the file name of the first chapter and the path as follows: { 
RD drive:\\directory\\subdirectory (if applicable)\\file name.file name 
extension}. 

• It might look like this: { RD c:\\My Documents\\book\\01.doc}. 

• Now go to the next line, click on  again, and enter the path for the 
next chapter etc. 
{ RD c:\\book\\01.doc} 
{ RD c:\\book\\02.doc}  
{ RD c:\\book\\03.doc}  
{ RD c:\\book\\04.doc}  
{ RD c:\\book\\05.doc} 

 
If you click on this button, the table of contents with headings 
down to the third level will be created automatically. 

Note: Do not use this function until all the chapters have been completed 
and you have checked that each chapter begins with the correct page num-
ber. 

If you make subsequent modifications to individual chapters causing 
changes to the text and page numbering, you will need to alter the table of 
contents accordingly. To do so, select the entire table of contents and press 
F9. 



11 Submitting the Manuscript to Springer-Verlag 

Please arrange with Springer-Verlag the form in which you are to submit 
your manuscript. 

11.1 Printout 

If it does not contain any grayscale figures, your paper printout can be 
used as the print master. In order to be used, it must be printed out on a 
600-dpi laser printer. 

Always keep the data and a copy of the printout. 

11.2 Data 

11.2.1 Postscript or PDF Files 

Ideally, the book should be printed directly from the data. In order to do 
so, we require PostScript or PDF files, and PostScript fonts must be used. 
The correct settings for saving the PDF data using Acrobat Distiller are 
shown in the Appendix. 

Please also send us a printout as a guide even if you are sending the 
electronic data. If there are any discrepancies between the electronic ver-
sion and the printout, we will assume that the electronic version is the 
correct one. 

11.2.2 Text and Graphics Files 

If, after your sample chapters have been examined (see Chap. 1), it is clear 
that the manuscript will need to be worked on by Springer-Verlag, you will 
be asked to submit your manuscript as a Word file. 
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In this case, save each chapter, including the accompanying references, 
figures (see also Chap. 7), and tables, in a separate file in both doc format 
and RTF (rich text format). Give each individual file the chapter number 
and the extension for the format (e.g., 01.doc, 02.doc, 01.rtf etc.). Submit 
the figures as separate files in tif or eps format (see Chap. 7). 

Here, too, we also require a definitive printout as a guide. 

11.2.3 Submission of Data 

Depending on the amount of data, you can submit your data on 3.5" disks, 
zip disks, or on CD-ROM. If you wish to submit your data by e-mail or 
FTP, please arrange this with your contact at Springer-Verlag. 



12 Additional Comments on Anthologies and 
Proceedings 

First name Surname 

Institute of XY, University of Somewhere 

The instructions compiled in this leaflet also apply to authors of antholo-
gies and proceedings, with the exceptions given below. 

 

Please use the document template SVcrproc.dot to produce the 
individual contributions. 

12.1 Instructions to Contributors 

12.1.1 Contribution Headers 

The title of the contribution is followed by the name(s) of the author(s). If 
there are several coauthors, the names should be separated by commas. 

 This button can be used to format the author line. 

The address of the institute or place of work is given in the next line. If 
different addresses are required for different authors, each address should 
begin on a new line, and superscript numbers should be used to indicate 
which author is affiliated to which institute etc. 

 This button can be used to style the author address(es). 

Please send your correct postal address on a separate sheet to the editor 
for the overall list of contributors. 

Tip: The top of this chapter can be used as an example for your contribu-
tion header. 
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12.1.2 Headers and Page Numbering 

Each contribution should begin on a right-hand (odd-numbered) page. The 
page number should appear in the so-called running headline (header), 
which also contains the author name(s) on the left-hand page and the title 
of the contribution on the right-hand page. 

Use the two buttons ”Right Header” and ”Left Header” to insert the 
headers. 

• Click on the first page and then on . Note: For aesthetic reasons, 
the first page has no header, but is included in the automatic page num-
bering. 

• Click on the second page and then on .  

As you do not initially know which pages of the overall work your con-
tribution will be appearing on, you should number your contribution 
starting at p. 1. The final numbering will be inserted by the editor or by 
Springer-Verlag. 

12.1.3 Marking Index Entries 

Please only mark index entries in the text if the editor has asked you to do 
so. 

12.2 Instructions to Editors 

You can also use the functions in the SVcrproc.dot document template to 
compile the contributions, to number the pages consecutively throughout, 
and to create the table of contents and the index. 

First save the contributions on your hard disk and, if necessary, attach 
the document template (see Chap. 2). 

12.2.1 Page Numbering 

Open the individual contributions one after the other, click on the header, 
and choose the menu point Insert – Page Numbers. Click on ”Format” and 
enter the (odd) page number that the contribution is to begin with at the 
bottom left of the dialog box under ”Page Numbering – Start At”. 

If any of the authors have not inserted headers, proceed as described in 
Chap. 8. 
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12.2.2 Index 

Please follow the instructions given in Chap. 9 to create the index. 

12.2.3 Table of Contents 

Please follow the instructions given in Sect. 10.2 to create the table of con-
tents. 

12.2.4 List of Contributors 

In the list of contributors, the authors are listed in alphabetical order. The 
addresses should be written as follows: 

 Line 1: surname, first name, title 
 Line 2: institute, clinic, university 
 Line 3: street and house number, postal code and town 
 Line 4: country, where applicable 

Example 

Smith, E., M.D. 
Department of Psychiatry, Sloan Kettering Memorial Hospital 
1275 York Avenue, New York, NY 10021 
USA 
 

 Use this button to format the first line. 

 Use this button to format the other lines. 

¶ Insert a blank space to separate the addresses. 
 





13 Legal Comments 

13.1 Trade Names 

If your book or contribution contains proprietary trade names or trade-
marks, it is advisable to point out that these names are protected by the 
firm or institution concerned. This can be done in the preface or acknowl-
edgments or on the imprint page. 

Example 

TEX is a trademark of the American Mathematical Society. 

13.2 Product Liability 

Under the law on product liability, all those involved in the production, re-
production, and processing of manuscripts have a greater duty of care. This 
applies particularly to the authors of academic and scientific works and 
reference books. In your own interest, too, we would therefore ask you to 
be conscientious when writing your work or contribution and during the 
subsequent proofreading and to ensure that that the information given in 
your manuscript is accurate and does not contain any errors. 

This task can be made easier by asking competent colleagues to check 
your information. That is the safest way to reduce your risk of liability and 
to avoid any claims for damages or rights of recourse. 

13.3 Copyright 

If you wish to copy figures, tables, or more than short text passages from 
other works, you must obtain permission from the copyright holder (the 
author or the publisher of the book concerned). Please ask your contact at 
Springer-Verlag for the relevant release forms. 
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The source must be acknowledged in the figure legend or table heading 
or in the text. 



14 FAQs 

The toolbar buttons do not work 

• Choose the menu point Templates and Add-ins in the Tools menu (Word 
97 and 2000) or the menu point Templates in the File menu (Word 95). 
Click on ”Attach” in the dialog box, choose SVcrmono.dot or 
SVcrproc.dot, and click on ”Update Styles” and then OK. 

• If a warning appears that the template contains macros, click on “Acti-
vate macros”. In Word 2000 choose Tools – Macro – Security and 
click on the middle level entry. If the warning appears,click on “Acti-
vate macros”. 

The headers are not inserted automatically 

• Double click on the *.dot file to create a new document. Then copy the 
existing text into the new document. The headers will be inserted auto-
matically. 

The macros for creating an index and the table of contents do 
not work 

• Save the chapters of your book in a separate directory on your hard 
disc, but not in the directory “My Documents”. 
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Type Area 

If you do not use Word or if you use a paper size other than A4 for the 
printout, e.g., US letter format, you will need to set up the type area your-
self. Please use the following measurements to do so (the measurements 
for the page margins are based on an A4 page): 
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Font Sizes 

The fonts are preset in Springer's document template. The following 
fonts/font sizes are used: 

Title Helvetica 14 pt, bold, 
spacing after: 84 pt 

H1 Helvetica 12 pt, bold, 
spacing before: 26 pt, spacing after: 14 pt 

H2 Helvetica 10 pt, bold, 
spacing before: 22 pt, spacing after: 11 pt 

H3 Helvetica 10 pt, bold, italics, 
spacing before: 16 pt, spacing after: 8 pt 

Text Times 11 pt, single line spacing, 
indent 0.4 cm 

Displayed lists Times 11 pt, single line spacing, 
hanging indent 0.4 cm 

Spacing 6 pt 

Petit Times 10 pt, single line spacing, 
indent 0.4 cm 

Important! Times 10 pt, single line spacing, 
indent 0.5 cm left and right, 
spacing before and after: 6 pt, frame with 2 pt spac-
ing 

References Times 10 pt, single line spacing, 
hanging indent 0.6 cm 

Footnote Times 10 pt, single line spacing, 
hanging indent 0.3 cm 

Table heading Times 10 pt, single line spacing, 
spacing before: 12 pt, spacing after 6 pt 

Table, table notes Times 10 pt, single line spacing, 
flush left 

Figure legend Times 10 pt, single line spacing, 
spacing before: 6 pt, spacing after: 12 pt 

Headers Times 10 pt, line spacing 11 pt, 
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spacing after: 6 pt, line below with 0.5 pt spacing 

Table of contents  Times 11 pt 

Index Times 10 pt 

Shortcuts 

To allow you to format your text quickly and easily, most of the functions 
in Springer's document template can be called up not only using the but-
tons in the toolbars, but also using keyboard shortcuts. 

 
Springer's document template 

Figure legend Ctrl+Shift+J 

Non-indented paragraph Ctrl+Shift+C 
Indented paragraph Ctrl+Shift+V 

Spacing Ctrl+Shift+X 

Address Ctrl+Shift+D 

Displayed list with bullets Ctrl+Shift+O 
Displayed list with dashes Ctrl+Shift+S 
Displayed list with numbers Ctrl+Shift+M 

Author Ctrl+Shift+A 

Square brackets Ctrl+Shift+G 

Insert equation Ctrl+Shift+Q 

Mark index entry Alt+Shift+X 

Left header Ctrl+Shift+8 
Right header Ctrl+Shift+9 

References Ctrl+Shift+R 

Petit Ctrl+Shift+I 

Table heading Ctrl+Shift+L 
Table note Ctrl+Shift+N 

Title Ctrl+Shift+T 
Heading 1 Ctrl+Shift+1 
Heading 2 Ctrl+Shift+2 
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Heading 3 Ctrl+Shift+3 

Important! Ctrl+Shift+W 
  

 
 
 
 
 
General Word shortcuts  

Bold Ctrl+F 
Italics Ctrl+K 

Cut Ctrl+X 
Insert Ctrl+V 
Copy Ctrl+C 

Save Ctrl+S 

Find and replace Ctrl+H 

Go to...  

 to the next paragraph Ctrl+↓ 
 to the end of the document Ctrl+End 
 to the beginning of the document Ctrl+Home 
 to the previous cursor insertion 

 point 
Shift+F5 

Select All Ctrl+A 

Update boxes F9 
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PostScript and PDF Files 

In order to be able to print directly from the data, we need PostScript or 
PDF files. Please do not create these files, however, until your manuscript 
has been sent to the publisher and approved and any necessary corrections 
have been made in the WORD file. 

PostScript File 

To create a PostScript file from your Word document, open the Print 
menu. Select a PostScript printer (or the Distiller) from the list. Click on 
the box "Print to file" and then click OK. 

Please note: 
• Only use PostScript Type 1 fonts (not True Type fonts). 
• All fonts which are used must be embedded. 
• The correct resolution must have been used for figures (see Chap. 7). 
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petit  6 
photos  21 
PostScript 
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